ADVERTISING SPECS

Effective April 1, 2022
### Ad Sizes - Broadsheet

<table>
<thead>
<tr>
<th>DISPLAY &amp; CLASSIFIED</th>
<th>LEGAL CLASSIFIED</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 column.............. 1.583”</td>
<td>1 column.............. 1.013”</td>
</tr>
<tr>
<td>2 column.............. 3.291”</td>
<td>2 column.............. 2.152”</td>
</tr>
<tr>
<td>3 column.............. 5.000”</td>
<td>3 column.............. 3.291”</td>
</tr>
<tr>
<td>4 column.............. 6.708”</td>
<td>4 column.............. 4.430”</td>
</tr>
<tr>
<td>5 column.............. 8.416”</td>
<td>5 column.............. 5.569”</td>
</tr>
<tr>
<td>6 column.............. 10.125”</td>
<td>6 column.............. 6.708”</td>
</tr>
<tr>
<td>Double Truck........... 21.125”</td>
<td>7 column.............. 7.847”</td>
</tr>
<tr>
<td>8 column.............. 8.986”</td>
<td>9 column.............. 10.125”</td>
</tr>
</tbody>
</table>

### Tabloid

<table>
<thead>
<tr>
<th>INSIDE OUT</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1 column.... 1.75”</td>
<td>1 column.... 1.013”</td>
</tr>
<tr>
<td>2 column.... 3.625”</td>
<td>2 column.... 2.152”</td>
</tr>
<tr>
<td>3 column.... 5.5”</td>
<td>3 column.... 3.291”</td>
</tr>
<tr>
<td>4 column.... 7.375”</td>
<td>4 column.... 4.430”</td>
</tr>
<tr>
<td>5 column.... 9.25”</td>
<td>5 column.... 5.569”</td>
</tr>
</tbody>
</table>

### Special Products

- Spadea: 2 Files @ 10.125” x 20”
- Front Page Strip Ad: 10.125” x 3”
- Front Page Ad Note (no bleed): 3” x 2.38”
- Front Page Ad Note (bleed): 3.2” x 2.65”
- Skybox Ad: 3.291” x 1.50”
- Overline Ad: 10.125” x 2”

### Preprint Inserts

Sizes available:
- 10.5” x 12”
- 8.5” x 11”
- 5.5” x 11”
- 8.5” x 7”

### Mechanical Specs - Print

For ads to be built, image file formats accepted for ad materials include: JPEG, PNG, TIF, EPS, AI. Please provide high resolution images. Images pulled from the internet or a Google image search will reproduce poorly in most cases. For ad copy, we accept Microsoft Office documents.

For camera-ready ads, the preferred file format is a press-ready PDF or EPS file with fonts converted to outlines and raster images in CMYK color format.

<table>
<thead>
<tr>
<th>Line Screen</th>
<th>DPI</th>
<th>Total Ink Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>200</td>
<td>240</td>
</tr>
</tbody>
</table>
ad sizes - broadsheet

- **Full Page**: 10.125 x 20
- **1/2 Page Vertical**: 5 x 20
- **1/2 Page Horizontal**: 10.125 x 9.9
- **1/4 Page Vertical**: 5 x 9.9
- **1/4 Page Horizontal**: 10.125 x 5
- **Strip Ad Horizontal**: 10.125 x 3
- **1/8 Page Square**: 5 x 5
- **1/12 Page Square**: 3.291 x 5
- **Center Spread Double Truck (with folios)**: 21.125 x 20

+ Gutter Space
<table>
<thead>
<tr>
<th>Ad Sizes</th>
<th>InsideOut - 5 Column Tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Page</td>
<td>INCHES 9.25 x 10</td>
</tr>
<tr>
<td>1/2 Page VERTICAL</td>
<td>INCHES 9.25 x 5</td>
</tr>
<tr>
<td>1/4 Page VERTICAL</td>
<td>INCHES 3.625 x 6.5</td>
</tr>
<tr>
<td>1/4 Page HORIZONTAL</td>
<td>INCHES 5.5 x 4.25</td>
</tr>
<tr>
<td>2 col x 3 HORIZONTAL</td>
<td>INCHES 3.625 x 3</td>
</tr>
<tr>
<td>2 col x 6 VERTICAL</td>
<td>INCHES 3.625 x 6</td>
</tr>
<tr>
<td>4 col x 3 HORIZONTAL</td>
<td>INCHES 7.375 x 3</td>
</tr>
<tr>
<td>2 col x 10 VERTICAL</td>
<td>INCHES 3.625 x 10</td>
</tr>
</tbody>
</table>
ad sizes - Gambit and Lagniappe

- Full Page: 9.221 x 9.999 inches
- 1/2 Page (Vertical): 4.551 x 4.937 inches
- 1/2 Page (Horizontal): 9.221 x 4.937 inches
- 1/4 Page (Vertical): 2.216 x 4.937 inches
- 1/4 Page (Square): 4.551 x 4.937 inches
- 1/8 Page (Horizontal): 4.551 x 2.406 inches
- 1/8 Page (Vertical): 2.216 x 2.406 inches
- 1/16 Page (Square): 2.216 x 2.406 inches
- Center Spread (Double Truck): 19.5 x 9.999 inches

Gambit and Lagniappe advertisements

Page 12

WHATEVER FLOATS YOUR BOAT
WHY ROBERT TANNEN BOUGHT A LIFEBOAT FOR WHITE LINEN NIGHT

Page 7

THETIMES-PICAYUNE | THENEWORLEANSADVOCATE
August 1, 2019
## Adore Fashion, Home Design, Decor

### Ad Sizes (Print)

<table>
<thead>
<tr>
<th>Ad Size</th>
<th>INCHES</th>
<th>TRIM:</th>
<th>BLEED:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Page</td>
<td>8.375 x 10.875</td>
<td>8.625 x 11.125</td>
<td></td>
</tr>
<tr>
<td>1/2 Page</td>
<td>7.875 x 5.125</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/3 Page</td>
<td>2.5 x 10.375</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/4 Page</td>
<td>3.85 x 5.125</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2-Page Spread</td>
<td>16.75 x 10.875</td>
<td>17 x 11.125</td>
<td></td>
</tr>
</tbody>
</table>

### Ad Sizes (Digital)

**Super Billboard**
- 970 x 250 pixels
- Static
- File size under 100 KB
- Accepted file formats: jpg, png, gif
- Third-party ad tags not accepted

**Parallax**
- Desktop: 1500 x 600 pixels
- Mobile: 300 x 350 pixels
- Static
- File size under 1 MB
- Accepted file formats: jpg, png, gif
- Third-party ad tags not accepted

**Rectangle**
- 300 x 250 pixels
- Static
- File size under 100 KB
- Accepted file formats: jpg, png, gif
- Third-party ad tags not accepted
print specifications - color settings

downloading ink settings

1. Visit: https://www.theadvocate.com/site/ink_settings_advocate.html (link is clickable here)
2. Download the custom ink settings for all our newsprint publications (.csf file) to your desktop or a folder for later use.
3. (Adobe Software) In the top menu bar, click **Edit > Color Settings** (steps are the same for Photoshop and InDesign).
4. Click load and navigate to the location of your file and click open; then click OK.
5. Click **Edit > Assign Profile**.
6. In **Photoshop**: choose the middle option for **"Working CMYK: GambitInkSettings"**; click OK.
7. In **InDesign**: choose the middle option for **RGB Profile** "Assign current working space: sRGB IEC61966-2.1" for CMYK Profile choose "Assign current working space: GambitInkSettings." Click OK.
8. Create a new file using the file sizes provided.
9. Design your ad.

things to keep in mind while designing

1. **Only CMYK or Grayscale color range files are accepted** - (Pantone, Spot and RGB will be converted accordingly)
2. **No rich black for text** - For black text, only use 100% black (no rich black)
3. **All text is at least 8 points in size** - If your text is not 100% black and is on top of any color but white (referred to as knock-out text), it must be at least 12 points and bold without any thin strokes or serifs. Avoid any ornate script fonts especially in knock-out situations.
4. **Your files are flattened** - Make sure when placing logos and images used are flattened files. Do not place layered logos or images. Design your ad.

exporting your ad

1. Be sure to **name your files clearly** including the client name and date:
   - **Good**: HarrysShop_6-13-15.pdf
   - **Bad**: 0942523AXD-Advocate.pdf
2. **If your ad was made in Photoshop only** - save the document as a .psd, then flatten it, then save it as a Photoshop PDF (make sure "Embeded Color Profile: GambitInkSettings" is checked at the bottom). Don't overwrite your original layered file. Saving it as a different file will keep your original file unflattened in case more changes need to be made. High quality photoshop JPEGS are also accepted.
3. **If your ad was made in both Photoshop and InDesign** - Save your photoshop documents, relink any files in InDesign. Make sure text is 100% Black with no other colors, convert text to outlines and export using File > Adobe PDF Presets > [PDF/X-1a:2001]... and submit your ad. (Remember to un-outline your font before you save your file so the text will still be editable if there are any typos.)
### deadlines - print

<table>
<thead>
<tr>
<th>Publication</th>
<th>Space Reservation</th>
<th>Creative Materials</th>
<th>Ad Release</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Monday Daily</strong>&lt;br&gt;BR, NO, ACA Classified</td>
<td>Thursday @ 5 pm</td>
<td>Friday @ noon</td>
<td>Friday @ 5 pm</td>
</tr>
<tr>
<td><strong>Tuesday Daily</strong>&lt;br&gt;BR, ACA Classified&lt;br&gt;NO Classified</td>
<td>Friday @ 5 pm</td>
<td>Monday @ noon</td>
<td>Monday @ 5 pm</td>
</tr>
<tr>
<td><strong>Wednesday Daily</strong>&lt;br&gt;BR, ACA Classified&lt;br&gt;NO Classified&lt;br&gt;Living BR&lt;br&gt;Living NO&lt;br&gt;Living ACA</td>
<td>Monday @ 5 pm</td>
<td>Tuesday @ noon</td>
<td>Tuesday @ 5 pm</td>
</tr>
<tr>
<td><strong>Thursday Daily</strong>&lt;br&gt;BR, ACA Classified&lt;br&gt;NO Classified&lt;br&gt;Lagniappe&lt;br&gt;Living BR&lt;br&gt;Living NO&lt;br&gt;Living ACA</td>
<td>Tuesday @ 5 pm</td>
<td>Wednesday @ noon</td>
<td>Wednesday @ 5 pm</td>
</tr>
<tr>
<td><strong>Friday Daily</strong>&lt;br&gt;BR, ACA Classified&lt;br&gt;NO Classified&lt;br&gt;Living BR&lt;br&gt;Living NO&lt;br&gt;Living ACA</td>
<td>Wednesday @ 5 pm</td>
<td>Thursday @ noon</td>
<td>Thursday @ 5 pm</td>
</tr>
<tr>
<td><strong>Saturday Daily</strong>&lt;br&gt;BR, ACA Classified&lt;br&gt;NO Classified&lt;br&gt;Living BR&lt;br&gt;Inside/Out NO&lt;br&gt;Living ACA</td>
<td>Thursday @ 5 pm</td>
<td>Friday @ noon</td>
<td>Friday @ 5 pm</td>
</tr>
<tr>
<td><strong>Sunday Daily</strong>&lt;br&gt;BR, ACA Classifieds, Homes&lt;br&gt;NO Classifieds, Homes&lt;br&gt;Living &amp; Business and Pre-Run A&lt;br&gt;Baton Rouge Spotlight - Select Distribution</td>
<td>Wednesday @ 5 pm</td>
<td>Friday @ noon</td>
<td>Friday @ 4 pm</td>
</tr>
<tr>
<td><strong>Weekly Newspapers (NOLA &amp; BR Wed)</strong>&lt;br&gt;New Orleans&lt;br&gt;Baton Rouge - Southeast, Southside, Mid City&lt;br&gt;Baton Rouge - Livingston, Ascension&lt;br&gt;Baton Rouge - Zachary Plainsman, St, Francisville&lt;br&gt;Democrat, Clinton Watchman)</td>
<td>Thursday @ 2 pm</td>
<td>Friday @ noon</td>
<td>Friday @ 5 pm</td>
</tr>
<tr>
<td><strong>Gambit</strong></td>
<td>Monday @ 5 pm</td>
<td>Wednesday @ 5 pm</td>
<td>Thursday @ 5 pm</td>
</tr>
</tbody>
</table>

The Creative Materials deadline is for both camera ready ads or ad materials for ads to be built by our creative team to be received by.
preprints - packaging requirements

1. **SUPPLEMENT SIZE** - Preprinted supplements must be at least 5” x 7” and not larger than 19.5” x 12”

2. **PAPER WEIGHT** - Minimum 30 lb. stock - Tabloid; Minimum 60 lb. stock - Single Sheet

3. **SKIDS** - Skids must be solid base with solid runners. Skid top should be wood and must conform in size to skid base. Deck must be covered in cardboard before loading to prevent curling. Shrink-wrapped skids must have protective corners to prevent crimping.

4. **STACKING** - Supplements must be brick stacked in convenient lifts (6” - 12”) well jogged with no turns. Supplements should be stacked so that most folded edges are turned toward the center of the skid. Cardboard tie sheets must be used between each tier and on top to prevent distortion. Supplements must be recessed a minimum of 1/2” from the skid edge (all sides) to prevent crimping. DO NOT tie supplements together in bundles. Skids must not exceed 5 1/2 feet in height, must contain the same number of copies (except for the last), and must contain a skid tag indicating product and number of copies.

5. **DELIVERY** - The shipping and receiving dock hours are 6:00 a.m. to 3:00 p.m., Monday through Friday. Deliveries cannot be accepted outside of those times. The Times-Picayune, Baton Rouge Advocate and Acadiana Advocate daily and Sunday paper deadline is 11 business days prior to run date. Baton Rouge community papers (Zachary Plainsman, Mid-City, Southside, Southeast, Ascension and Livingston-Tangipahoa), New Orleans community papers (Crescent City, West Bank, East Jefferson and St. Tammany) are 9 business days prior. All inserts should be broken out and labeled according to edition. Earlier deadlines apply for holidays. Contact your sales representative for details. A proper bill of lading must accompany all shipments and should indicate (1) Advertiser, (2) # of skids and (3) # of copies. Supplements must be shipped prepaid to:

The Advocate  
10715 Rieger Road, Baton Rouge, LA 70809  
Phone: 225-377-2051 or 225-377-7078

Earlier deadlines apply for holidays. Call for details.
digital specifications

**LEADERBOARD** (desktop only)

728 × 90 pixels
- Animated or Static
- File size under 100 KB
- Accepted file format: jpg, png, gif
- Third-party ad tags are accepted

**RECTANGLE**

300 × 250 pixels
- Animated or Static
- File size under 100 KB
- Accepted file format: jpg, png, gif
- Third-party ad tags are accepted

**REVEAL**

**DESKTOP**

1920 × 600 pixels
- Animated, video (optional) or static
- Max File size: 150k
- Can include up to three images
- File format: jpg, png, YouTube
- Max video length: 15–30 seconds
- Max of one video
- Max of one URL clickthrough
- Third-party ad tags not accepted

**MOBILE**

800 × 250 pixels
- Static only
- Max File size: 80k
- File format: jpg, png
- Third-party ad tags not accepted

[CLICK HERE FOR EXAMPLE]
digital specifications

SLIDING BILLBOARD

DESKTOP
1170 × 50 pixels (collapsed)
- Static
- File size under 100 KB
- Leave blank a 100px overlay on right for expand/close button
- Accepted file formats: jpg, png
- Third-party ad tags not accepted

1170 × 300 pixels (expanded)
- Static
- File size under 100 KB
- Accepted file formats: jpg, png
- Third-party ad tags not accepted

MOBILE
480 × 50 pixels (collapsed)
- Static
- File size under 40 KB
- Leave blank a 50px overlay on right for expand/close button
- Accepted file formats: jpg, png
- Third-party ad tags not accepted

480 × 250 pixels (expanded)
- Static
- File size under 40 KB
- Accepted file formats: jpg, png
- Third-party ad tags not accepted

MOBILE BANNER
320 × 50
- Animated or Static
- File size under 100 KB
- Accepted file format: jpg, png, gif
- Third-party ad tags are accepted
digital specifications

SLIDING BILLBOARD & SITE SKIN
DESKTOP
1170 x 50 pixels (collapsed)
• Static
• File size under 100 KB
• Leave blank a 100px overlay on right for expand/close button
• Accepted file formats: jpg, png
• Third-party ad tags not accepted

1170 x 300 pixels (expanded)
• Static
• File size under 100 KB
• Accepted file formats: jpg, png
• Third-party ad tags not accepted

SITE SKIN DESKTOP
500 x 1100 (2)
• Static
• File size under 100 KB
• One image anchors to the left side of the browser window, the other to the right
• Accepted file formats: jpg, png
• Third-party ad tags not accepted

MOBILE
480 x 50 pixels (collapsed)
• Static
• File size under 40 KB
• Leave blank a 50px overlay on right for expand/close button
• Accepted file formats: jpg, png
• Third-party ad tags not accepted

480 x 250 pixels (expanded)
• Static
• File size under 40 KB
• Accepted file formats: jpg, png
• Third-party ad tags not accepted

EXPANDABLE VIDEO (desktop only)
300 x 250 pixels expands to 600 x 250 pixels
• Need static 300x250 (JPG or PNG) - File size under 100 KB
• Need original video file
• Need logo
• Need Clickthrough URL
• Need URLs for Social Media Channels (Optional)
• Third-party ad tags not accepted

CLICK HERE FOR EXAMPLE
digital specifications

**BOTTOM BAR**
**DESKTOP**
1170 x 50 pixels
- Static
- File size under 100 KB
- Accepted file formats: jpg, png
- Third-party ad tags not accepted

**MOBILE**
480 x 50 pixels
- Static
- File size under 40 KB
- Accepted file formats: jpg, png
- Third-party ad tags not accepted

**SUPER BILLBOARD**
**DESKTOP ONLY**
970 x 250 pixels
- Static
- File size under 100 KB
- Accepted file formats: jpg, png
- Third-party ad tags not accepted

CLICK HERE FOR EXAMPLE
### out-of-home specifications

ALL DIMENSIONS IN PIXELS
PLEASE CONTACT YOUR SALES REPRESENTATIVE ON VIDEO OPTIONS

<table>
<thead>
<tr>
<th>Educational Institutions</th>
<th>Outdoor Billboards</th>
</tr>
</thead>
<tbody>
<tr>
<td>• 1080x1920</td>
<td>• 1400 x 400</td>
</tr>
<tr>
<td>• 1280x720</td>
<td>• 1920 x 1080</td>
</tr>
<tr>
<td>• 1920x1080</td>
<td>• 256 x 192</td>
</tr>
<tr>
<td>Bars</td>
<td>• 320 x 144</td>
</tr>
<tr>
<td>• 1080x1920</td>
<td>• 320 x 160</td>
</tr>
<tr>
<td>• 1280x720</td>
<td>• 336 x 128</td>
</tr>
<tr>
<td>• 1366x768</td>
<td>• 336 x 160</td>
</tr>
<tr>
<td>• 1920x1080</td>
<td>• 368 x 176</td>
</tr>
<tr>
<td>• 720x480</td>
<td>• 384 x 144</td>
</tr>
<tr>
<td>Casual Dining Venues</td>
<td>• 384 x 216</td>
</tr>
<tr>
<td>• 1080x1920</td>
<td>• 400 x 160</td>
</tr>
<tr>
<td>• 1280x720</td>
<td>• 414 x 198</td>
</tr>
<tr>
<td>• 1366x768</td>
<td>• 432 x 144</td>
</tr>
<tr>
<td>• 1920x1080</td>
<td>• 464 x 144</td>
</tr>
<tr>
<td>• 720x480</td>
<td>• 480 x 112</td>
</tr>
<tr>
<td>Golf Carts</td>
<td>• 480 x 216</td>
</tr>
<tr>
<td>• 640x360</td>
<td>• 496 x 160</td>
</tr>
<tr>
<td>Hotels</td>
<td>• 528 x 144</td>
</tr>
<tr>
<td>• 1920x1080</td>
<td>• 528 x 160</td>
</tr>
<tr>
<td>Movie Theaters</td>
<td>• 544 x 144</td>
</tr>
<tr>
<td>• 1080x1920</td>
<td>• 544 x 160</td>
</tr>
<tr>
<td>Entertainment - Recreational</td>
<td>• 560 x 144</td>
</tr>
<tr>
<td>• 1366x768</td>
<td>• 576 x 216</td>
</tr>
<tr>
<td>• 720x480</td>
<td>• 612 x 162</td>
</tr>
<tr>
<td>Entertainment - Sports</td>
<td>• 624 x 176</td>
</tr>
<tr>
<td>• 1080x1920</td>
<td>• 630 x 162</td>
</tr>
<tr>
<td>• 1920x1080</td>
<td>• 630 x 180</td>
</tr>
<tr>
<td>Entertainment - Sports</td>
<td>• 640 x 180</td>
</tr>
<tr>
<td>• 1080x1920</td>
<td>• 640 x 192</td>
</tr>
<tr>
<td>• 1920x1080</td>
<td>• 660 x 180</td>
</tr>
<tr>
<td>• 1080x1920</td>
<td>• 704 x 192</td>
</tr>
<tr>
<td>• 1920x1080</td>
<td>• 720 x 208</td>
</tr>
<tr>
<td>• 1080x1920</td>
<td>• 752 x 208</td>
</tr>
<tr>
<td>• 1920x1080</td>
<td>• 760 x 180</td>
</tr>
<tr>
<td>• 1080x1920</td>
<td>• 840 x 400</td>
</tr>
</tbody>
</table>
out-of-home specifications

ALL DIMENSIONS IN PIXELS
PLEASE CONTACT YOUR SALES REPRESENTATIVE ON VIDEO OPTIONS

Outdoor Billboards - Highway
• 1000 x 625
• 1400 x 400
• 1600 x 400
• 840 x 400

Outdoor Billboards - Spectacular
• 1920x1080

Point of Care - Doctors' Offices
• 1080x1920
• 1280x720
• 1360x768
• 1366x768
• 1920x1080

Point of Care - Hospital
• 1920x1080

Point of Care - Veterinary Office
• 1280x720
• 1360x768
• 1920x1080

Retail - Gas Stations
• 1280x960

Retail - Grocery
• 1080x1920
• 1280x960
• 1920x1080
• 728x90

Retail - Liquor Stores
• 1920x1080

Retail - Malls
• 1080x1920

Retail - Pharmacies
• 1920x1080
• 728x90
• 970x90

Transit - Airports - Baggage Claim
• 1080x1920
• 1920x1080

Retail - Convenience Store
• 1280x960
• 1920x1080